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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operate, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Referto the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

e The M-Duino Family PLCs are Open Type Controllers. It is required that you install the
M-Duino PLC in a housing, cabinet, or electric control room. Entry to the housing,



Ref: 006001000700 Rev 2:12/11/2020

cabinet, or electric control room should be limited to authorized personnel. Failure to
follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when installing M-Duino family
PLCs.

e In case of installation or maintenance of the M-Duino please follow the instructions
marked in the Installation and Maintenance section.

e Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

e Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contrdleur.

e Une utilisation incorrecte de ce produit peut endommager gravement le contréleur.

e Reportez-vous au Guide de I'utilisateur du contréleur pour les considérations de
cablage.

e Avant d’utiliser ce produit, il incombe a I'utilisateur de lire le Guide de l'utilisateur du
produit et la documentation qui I'accompagne.

e La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

e La maintenance doit étre effectuée avec I'’équipement hors service et déconnectée de
toutes les sources d'alimentation.

e Faites attention lors de I'entretien des composants sensibles a I'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

e Les automates de la famille M-Duino sont des contréleurs de type ouvert. Il est
nécessaire d'installer |'automate M-Duino dans un boftier, une armoire ou une salle de
contrdle électrique. L'acces au boitier, a l'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille M-Duino.

e En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

e Ne débranchez pas I'équipement en présence d'une atmosphere inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

e Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.
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Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or stablish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.

Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’'S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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INDUSTRIAL SHIELDS

1 General Description GPRS / GSM CONTROLLER 38AR 1/0s
PLUS

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is
important to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the
shield from below and C the shield from above. Having a B in the middle of them. It has
3 zones (A, B, C):

N
1

i

SHSunem |
nmmmnEsEse |

| s o [{TTTT I 4
snnem T

A ZONE
B ZONE
CZONE
CZONE
B ZONE
A ZONE

C ZONE
B ZONE
( <midy,' AZONE

e The inputs in the zone B are named 10.X, being X any number suitable in the
Shield. Outputs are named as Q0.X and relays as R0.X

e The inputs in the zone C are named I1.X, being X any number suitable in the
Shield. Digital Outputs are named as Q1.X and Analog Outputs as A1.X.

10
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1.2

Zone Distribution
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"G Y Y
ZONEA |—| ZONEB L ZONE C
v
Communication
— Analog Relay

L+  Digital

The distribution of the different features that provide the M-Duino 19R 1/0Os PLUS is the

following one:

Shields B Zone C Zone
12 Inputs
. 4 Inputs
(12 Digital Inputs, “ Digitarl) Inputs
6 of which can work as Analog . '
- 4 of which can work as Analog
Digital/Analog Input) Input)
and Relay P
Shield 8 Outputs 11 Outputs
(8 Digital Outputs, (8 Relay Output
3 of which can work as Analog 3 Digital/Analo Out’ ut)
Output) g g P
1.3 A Zone Features

A Zone

Shield
(1x) Ethernet
(1x) USB
(1x) 12C
(3x) TTL
Communication | (1x) RS-232

Shield

(1x) RTC
(1x) uSD Socket
(1x) GPRS/GSM

(1x) HALF/FULL Duplex RS-485
(1x) SPI external Port

11
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1.1 Mechanical dimension

1.2  General Features

CONECTABLE PLC ARDUINO 24 VCC M-DUINO

GRPS/GSM Controller General .
MODEL TYPE A Information
Specifications
Fuse Protection (2.5 A) Polarity
Input Voltage 12to 24 Vde protection
| max. 15A
Size 101x119.5x70.1
Clock Speed 16 MHz
Flash Memory 256 KB of which 8 KB used by bootloader
SRAM 8 KB
EEPROM 4 KB
: - 12C — Ethernet Port — USB — GPRS — RS485 — RS232 — SPI MAX232 — MAX485 — W5500 —
Communications — (2x) RX, TX (Arduino pins) Sim800L
. . Only meant for uploading or debbuging, NOT ALWAYS Cannot be working in a final
USB Consideration! connected as a serial in a project! application
. . Oto 10V
An/Dig Input 10 bits Input Impedance: 39K
(0_10 VCC) Separated PCB ground
L. 5to 24 Vdc
Digital Isolated Input | min: 2 to 12 mA
(24 VCC) Galvanic Isolation

12
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*Interrupt Isolated Input Hs
(24 Vcce)

510 24 Vdc
I min: 2 to 12 mA
Galvanic Isolation

Analog Output 8 bits
(0 -10 Vce)

0to 10 Vdc
I max: 20 mA
Sperated PCB Ground

Digital Isolated Output
(24 Vcce)

510 24 Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay

| max 24 Vdc: 410 mA

Digital Isolated Output
(Relay)

24 VDC /220 VAC
I max: 5 A
Galvanic Isoltation
Diode Protected for Relay

PWM Isolated Output 8 bits
(24 Vcc)

510 24 Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay

Expandability

12C — 127 elements — Serial Port RS232 / RS485 / GPRS

*By using this type of signal can no longer use Digital signal (24 Vdc)

13
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2 Technical Specifications:

2.1  General Specifications:

Item

M-Duino PLC

Power supply

voltage DC power supply

12to 24Vdc ===

Operating

voltage range DC power supply

11.4t025.4Vdc ===

Power
consumption DC power supply 30VAC max.
Power supply 2avde ===
External voltage
power supply Power supply 700Ma

output capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the
external AC terminals and the protective ground terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 388g max.

2.2 Performance Specification:

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programming language. “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

Microcontroller

ATmega2560

Flash Memory

256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB
EEPROM 4KB

Clock Speed 16MHz

Clock Speed 16MHz

14
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Table that includes all the symbology that is used in the serigraph of the M-Duino PLC Arduino
Ethernet 58 1/Os Analog/Digital PLUS:

Svmbol Standard No./ Standard
y Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / : : .
| Graphical symbols 5031 / Direct Indicates that the equipment is
- . . f suitable for direct current only;
or use on Current . : :
; to identify relevant terminals
equipment
IEC 60417 / Indicates that the equipment is
Graphical symbols . suitable for alternating current
TN for use on 5032 C/:Alternatmg only; to identify relevant
, urrent )
equipment terminals
IEC 60417 /
Graphical symbols 5130 / Pulse To _|dent|fy the_control by
for use on which a pulse is started.
, General
equipment
IEC 60417 / To identify an earth (ground)
Graphical symbols terminal in cases where
for use on 5017/ Earth, neither the symbol 5018 nor
- Ground : - ;
equipment 5019 is explicily required.
IEC 60417 / . . .
Graphical symbols To identify the swﬂch by
means of which the signal
for use on 5115/ Slgnal lamp . .
; lamp(s) is (are) switched on or
equipment off

C€

Medical Devices

CE marking indicates that a
product complies with

Directive CE Marking . .
93/42/EEC applicable Euro_pean Union
regulations
ISO 7000/ Indicates a potentially
Graehlcal symbols 0434B / hazardous situation which, if
or use on . . .
) Warning symbol not avoided, could result in
equipment d . L
eath or serious injury
ISO 7000/
Gra;:hlcal symbols 5036 / Dangerous To indicate hazards arising
or use on
) Voltage from dangerous voltages
equipment

15
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3 Precautions

Read this manual before attempting to use the GPRS/GSM 38AR I/Os PLUS PLC and follow its
descriptions for reference during operation.

3.1 Arduino Board

The GPRS/GSM Controller includes an Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate M-Duino according to the performance specifications described in this
manual.

Before using the GPRS/GSM Controller under different conditions from what has been
specified in this manual or integrating GPRS/GSM Controller to nuclear control systems,
railroad systems, aviation systems, vehicles, combustion systems, medical equipment,
amusement machines, safety equipment and other systems, machines, and equipment that
may have a serious influence on lives and property if used improperly, consult your
INDUSTRIAL SHIELDS representative. Ensure that the rating and performance characteristics of
GPRS/GSM Controller are sufficient for the systems, machines, and equipment, and be sure to
provide the systems, machines, and equipment double safety mechanisms. This manual
provides information for programming and operating the GPRS/GSM 38AR 1/Os PLUS
Controller.

16
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Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C

language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Industrial Shields provides boards for programming the PLCs much easier. Basically, it is no
needed to define the pins and if that pins are inputs or outputs. Everything is set up

automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.0 or above (better to always have the latest version).

Steps:

1.

2.

Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X

Settings  Network

Sketchbool: location:

:\Users\Albert\Documents\Arduino Browse
Editor language: English (English) | (requires restart of Arcing)

Editor font size: 15

Interface scale: Automatic | 100 T %  (requires restart of Arduing)

Show verbose output during: compilation upload
Compiler warnings: None

[ pisplay line numbers

[CJEnable code Folding

Verify code after upload

[ use external editor

Checl for updates on startup

Update sketch files to new extension on save (.pde -> .ino)
Save when verifying or uploading

Additional Boards Manager URLs:  http://apps.industrialshields.com/main/arduina/boards/paclage_industrialshields_inde; [

More preferences can be edited directly in the file
C:\Users\albert\AppData ocal\Arduino15\preferences. tet
(edit only when Arduina is not running)

Ok Cancel

In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3.

Press OK to save the changes.

17
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4. Go to: Tools -> Board: ... -> Boards Manager

@ skeich marl6a | Arduino 180
File Edit Sketch Tools Help

Auto Format Cul+T
Archive Sketch
Fix Encoding & Reload

Serial Monitor Ctrl4ShiftsM
Sertal Plotter Cul+Shittsl

WFi101 Finmware Updater

Board: “M-Duino lamily” + Boards Manager...
Indusirial Shvelds: "M-Duino 58+ 7 Arduino AVR Boards
" pon Arduino Yin
"t Get Board Info Asduino/Gensino Una
, Programmer: “Archiino as ISP i Arduino Duemilanove or Diecimila

Arduine Nano

Arcuino/Gerano Mega o Mega 2560
Arduin Mega ADK

Arduing Leonardo

Arduina Leonardo ETH
Arduino/Genuine Micro

Arduino Esplora

Arduino Mini

Arduina Ethernet

Bum Bootioader

Arcuina Fio
Arduino BT

LilyPad Archuino USB
LilyPad Arduino

Arduine Pro of Pro Min
Arduing NG or older
Arduino Robot Control
Arduing Robot Motor
Arduino Gemma

Adatruit Cireuit Playground
Arduing Yuin Mini
Arduina Incustrial 101
Linina One

Arching Uno Wikl

Industrial §
Ardbox tamily
* M-Duino family

5. Search for “industrialshields” on the browser.

& Boards Manager %
Type All ~ | |industrialshields
industrialshields &

Boards included in this package:
ARDBOX family, M-Duino family.

Online help
More info

~ Install

Close

18
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6. Click install (selecting the latest version).
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Following these steps, you will be able to see now the Industrial Shields Boards:

9 sketch_auglda | Arduine 189
File Edit Sketch Tools Help

sketeh_augi4

void setup(
// put yoi

1

woid loop()
// put yo

Auto Format Ctrl+T
Archive Sketch

Fix Encoding & Reload

Manage Libraries... Ctrl+Shift+|
Serial Monitor Ctrl+Shift+M
Serial Plotter Ctrl+Shift+L

WiFi101 / WiFiNINA Firmware Updater

Board: "M-Duino family"
Model: "M-Duino 19R"
Port

Get Board Info

Programmer: "Arduine as ISP"

Burn Bootloader

Boards Manager...
A

Arduino Fio

Arduino BT

LilyPad Arduino USB

LilyPad Arduino

Arduino Pro or Pro Mini
Arduino NG or older
Arduino Robot Contral
Arduino Robot Motor
Arduino Gemma

Adafruit Circuit Playground
Arduino Yin Mini

Arduino Industrial 101
Linino One

Arduino Uno WiFi

Industrial Shields ESP32 modules
WiFi module

Industrial Shields boards

Ardbox family

Ardbox GPRS family

Ardbox WiFi/BT family
®  M-Duino family

M-Duinc GPRS family

M-Duinc WiFi/BT family
W

Once it is selected the family an extra option will appear on Tools:

There, it can be selected the exact model for every family. In this case M-Duino 38AR + GPRS

@ sketch_aug13a | Arduino 1.8.9
File Edit Sketch Tools Help

sketch_augl3

void setup
// put v

void loop (
// put v

Auto Format

Archive Sketch

Fix Encoding & Reload
Manage Libraries...
Serial Monitor

Serial Plotter

WiFi101 / WiFiNINA Firmware Updater

Board: "M-Duino GPRS family"
Madel: "M-Duino 19R+ GPRS"
Port

Get Board Info

Programmer: "Arduino Gemma"
Burn Bootloader

Ctrl+T

Ctrl+Shift+]
Ctrl+Shift+M
Ctrl+Shift+L

[& M-Duinc 19R+ GPRS
M-Duino 21+ GPRS
M-Duino 38AR+ GPRS
M-Duino 38R+ GPRS
M-Duino 42+ GPRS
M-Duino S0RRA+ GPRS

M-Duino 53ARR+ GPRS
M-Duino 54ARA+ GPRS
M-Duino 57TAAR+ GPRS
M-Duino 57R+ GPRS
M-Duino 58+ GPRS

19
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Also, there are some examples of programming in File -> Examples -> M-Duino GPRS Family.
Furthermore, there are some extra libraries that can be found in Industrial Shields GitHub.

https://github.com/IndustrialShields/
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5 How to connect PLC Arduino to PC
- Connect USB port from PLC to PC.

NOTE:
M-Duino Family uses USB-B cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> M-Duino GPRS Family

- Select the correct M-Duino Board:
M-Duino 38AR + GPRS

@ sketch_aug13a | Arduino 1.89
File Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch
sketch_aug13 Fix Encoding & Reload
. Manage Libraries... Ctrl+Shift+I
volid setup i } -
// e Serial Monitor Ctrl+Shift+M
u
PR Y Serial Plotter Ctrl+ShiftsL
} WiFi101 / WiFiNINA Firmware Updater
) Board: "M-Duino GPRS family” >
veie 1oop 0 \odel: "M-Duino 19R+ GPRS® [® M-Duino 19R+ GPRS
/] put ¥ pog M-Duino 21+ GPRS
Get Board Info M-Duino 38AR+ GPRS
} L . M-Duino 38R+ GPRS
Programmer: "Arduino Gemma L BhTree £ (TS
-Duino 42+
Burn Bootloader )
M-Duino 50RRA+ GPRS

M-Duino 53ARR+ GPRS
M-Duino 54ARA+ GPRS
M-Duino 5TAAR+ GPRS
M-Duino 57R+ GPRS
M-Duino 58+ GPRS

- Select correct port.

(&9 sketch_augl4a | Arduino 1.8.9
File Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch
sketch_aug14 Fix Encoding & Reload
void setup( Manage Libraries... Ctrl+Shift+|
/4 PUE YO eerial Monitor Ctrl+ Shift+ M
Serial Plotter Ctrl+Shift+L

WIFi101 / WiFiNINA Firmware Updater
void loop()

/i put yor Board: "M-Duino WiFi/BT family" H]
Medel: "M-Duine 19R+ WiFi/BT" >
! Port : Serial ports
Get Board Info COMT2 (Arduino/Genuino Mega or Mega 2360)
Programmer: "Arduino as ISP" >

Burn Bootloader
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6 How to connect PLC to power supply

- M-Duino Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

[——
u GND I

|—1I 24Voe |

| I

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm

DIN Rail: g
-12vdc / 24Vdc =

-2.5A

-30W

Industrial Shields power supplies provide parallel
operation, overvoltage protection, and overcurrent

TR RE

protection. There is a LED inductor for power status,
the power supply is certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-
1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.
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7 M-duino Family Pinout

7.1 A Zone connection
Base
(common unit)
A Zone
5 £
o o
28] ¢ 5
S C 5 S
25| € 5
=0 < [y
SCL 21 12C/SS
SDA 20 12C/SS
RX0 1 RX0/SS
TXO0 0 TX0/SS
RX1* 19 RX1/SS
TX1* 18 TX1/SS
> 16 RX2(serial 2)
RX 17 TX2(serial 2)
Z- - RS485
Y+ - RS485
B- - RS485
A+ - RS485
PIN3 3 Arduino Pin
50 SO 50 SPI
51 Sl 51 SPI
52 SCK 52 SPI
Reset | Reset SPI
Vin5 Vin5 5V
NC NC Not Connected
GND - Gnd
GND - Gnd
24Vdc Power Supply

s

ARef
saw
IORef
3.3vdc
5Vdc
Gnd

SCL

o
®
3

]

Rev 2:12/11/2020

Configuration Switch* (see section 8 for
configuring the communications.
Enabling communications disables some
1/0s)

Rx1/Tx1 * Pins used for the GPRS module

Communication Pins

Power supply connectors
(24Vdc - GND)

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any device.

Base
(common unit)
A Zone
5 £
o
o "5‘ c
c o
= o % .%
o c S c
1 o - =1
=0 < [}
AREF AREF  |Arduino PIN
IOREF2 | IOREF2 |Arduino PIN
IOREF1 | IOREF1 |[Arduino PIN
7Vvdc 7Vdc -
GND GND GND
3.3vdc | 3.3vdc |Arduino PIN
GND GND GND
5Vvdc 5Vdc -
GND GND GND

=

OFF ON
SCL/I12.6
SDA/I25
Rx1/11.6
Tx1/11.5

Pin3/106
Pin2/10.5
D53(SD)
FD rs4ss HD
OFF ON

NC
NC
RTC SCL
RTC SDA
g N
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é 8
. %g z3 W
L] on I
- 4 <Ez\J P "
B i2 CE g e
§ < _Reser [ usB B Frogam | @ K2
E5 RTC Banery (CB#D) *uSD Socket[J
Ethernet Arduino / Power
Connector Reset button

USB programmer
connector

Autoreset

*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using
serial communication. When uploading code to Arduino Mega set switch to ON.
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7.2 B Zone (Analog Shield)

B Zone
o8 <
c = o
=R 2 IS
I | 3 E
o < z
10.12 59 Analog/ Digital In
10.11 58 Analog/ Digital In
10.10 57 Analog/ Digital In
10.9 56 Analog/ Digital In
10.8 55 Analog/ Digital In
10.7 54 Analog/ Digital In
(-)10.6/INT1 - GND 10.6
10.6/INT1% 3 Interrupt 1 In
NC - Not Connected
NC - Not Connected
(-)I0.4 - GND 10.4
10.4 26 Digital Input
(-)10.3 - GND 10.3
10.3 25 Digital Input
(-)10.2 - GND 10.2
10.2 24 Digital Input
(-)I0.1 - GND 10.1
10.1 23 Digital Input
(-)10.0 - GND 10.0
10.0 22 Digital Input
Top Zone
O | seE | ogow gan i tin o | —
crolo g g goinion
523358352582 2 s

Led indicator 1/Os state

—ofTo—
Analog:
0-10vde
Digital
5-24vdc
Digital-
5-24Vdc

GND —]

10.12 —ofT¥
10.11 —ofT¥
10.10—efT%
109 —ofo
108 —ofT0
10.7 —offx
() I06ANT 1
10 6/INT 1

NC o]

() 10.4—
104 -
() 10.3—
103 o
() 10.2—
102 o
()10.1—
101 o
() 10.0—
100 o

B Zone

e5s c

5| ¢ 5

ac e I3]

=5 3 s

o
o = T
<

GND GND GND
A0.7* 6 Analog Out
A0.6* 5 Analog Out
A0.5t 4 Analog Out
Q/Vvdc - External Isolated Out Vdc
COM(-) - External Isolated Out GND
QO0.7* 6 Digital/PWM Out
Q0.6 5 Digital/PWM Out
Q0.5 4 Digital/PWM Out
Q0.4 40 Digital Out
Q0.3 39 Digital Out
Q0.2 38 Digital Out
Q0.1 37 Digital Out
Q0.0 36 Digital Out
Relay Shield

1 See section 8 to select suitable switch configuration for enable these connections.

OM: DIGITAL
OFF: ANALOG

Ja
2 Analog:
0-10Vde

—Bigtar

QiVde

C§ Digital/PWM

* Note: use correctly configuration for

use this signal
(see user guide)

Q/vde

GND
AO.T

Rev 2:12/11/2020

Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isolated)

Configuration Switch*
(see section 8 to select the correct
configuration for outputs).

Analog Outputs

Voltage Supply/Reference for
Digital/PWM Outputs (isolated)

PWM/Digital Outputs
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7.3  CZone (Relay Shield)
C Zone
o5 | £
= o

S o

> 2 2 S

2 | 3 g

= 8 z 3
R1.8 42 Relay Out
R1.7 43 Relay Out
R1.6 44 Relay Out
R1.5 45 Relay Out
R1.4 29 Relay Out
Al.2t 11 Analog Out
Al.1t 10 Analog Out
A1.0t 8 Analog Out
GND GND GND
Q1.2 11 Digital/PWM Out
QL1 10 Digital/PWM Out
Q1.0t 8 Digital/PWM Out

GNDCOM - External Isolated Out GND
24VCOM - External Isolated Out Vdc

Led indicator I/Os state

COM(-)

R1.8

R1.7

R1.

(=]

R1.5

R1.4

Analog

0-10vde
8 Digital/PWM

Q/vde

3

Q/vde—|

C Zone

2 £ c
S5 0 o o
Qe o 3
=5 5 5

$) = o

<

R1.3 30 Relay Out
R1.2 27 Relay Out
R1.1 28 Relay Out
GND GND GND
11.5 63 Analog/Digital Input
11.4 62 Analog/Digital Input
11.3 61 Analog/Digital Input
11.2 60 Analog/Digital Input
NC - Not Connected
NC - Not Connected
NC - Not Connected
NC - Not Connected

See section 8 to select suitable switch configuration for enable these connections.

R1.3
R1.2
R1.1
—De—
Analog:
0-10vdc
Digital:
5-24vde
—e
Digital:
5-24vdc
— GND
- 115
2 114
S 13
g nz
é, 5o~ NC
c — NC
o 5~ NC
z — NC
.
E_T
SEE 48[ne
29> £1|Q12
@ 5 « 8%
228 ailen
ﬁf? § zk|aio
T 52

Rev 2:12/11/2020

Relay Outputs

Analog Output (Switch
Configuration)

Digital/PWM Outputs
(isolated)

Relay Outputs

Analog/Digital Inputs
Interrupt Inputs (isolated)
Configuration Switch*

(see section 8 to select correct
configuration for outputs).
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8 Switch Configuration

8.1

o )

A Zone: Communications

LEFT ZONE
Switch Relay Shield
ON | OFF
D ZONE
SCL/NC NC SCL
SDA/NC NC SDA
C ZONE
GPRS/NC NC GPRS
GPRS/NC NC GPRS
B ZONE
Pin 3/10.6 10.6 Pin 3
GPRS RST/NC NC GPRS
RST
uSD & RS-485
D53(SD) - SD
FD RS-485 HD HD FD
OFF ON
SCL/NC
SDA/NC
GPRS /NC
GPRS/NC
Pin3/10.6
GPRS RST/ NC
D53(SD)
FD RS485 HD
OFF ON

Rev 2:12/11/2020

8. SCL/NC: ALWAYS AT OFF POSITION. On a GPRS/GSM Controller this switch is not

connected.

7. SDA/NC: ALWAYS AT OFF POSITION.On a GPRS/GSM Controller this switch is not

connected.

6. GPRS/NC: ALWAYS AT OFF POSITION. On a GPRS/GSM Controller this switch is not

connected.

5 . GPRS/NC: ALWAYS AT OFF POSITION. On a GPRS/GSM Controller this switch is not

connected.

4. Pin 3/10.6: Choosing between Pin 3 or the input 10.1. If this switch is ON, it enables the 10.1
input and disables the Pin 3. If this switch is OFF, it enables Pin 3 and disables 10.1.
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3. GPRS RST/NC: ALWAYS AT OFF POSITION. GPRS RST is used by the Sim800L module (The
GPRS/GSM Module).

2. D53(SD): ALWAYS AT OFF POSITION. On a GPRS/GSM Controller this switch allows
the uSD storage, if this switch is ON, it does not enable any pin.

1. FD RS-485 HD: Choosing between FD or HF. If this switch is ON, it enables the Half
Duplex (HD) option and disables the FD. If this switch is OFF, it enables Full Duplex (FD)
and disables HD.

OFF ON
LEFT ZONE
SWITCH ON OFF NC NC
NC - - NC NC
Ne ' : RTC SCL
RTC SCL RTC -
RTC SDA RTC : RTC  SDA

1. RTC SDA: This switch enables the communication to communicate with the RTC
using 12C. Having this switch in ON mode it actives this communication,
whereas if it is in OFF mode it disables the 12C to reach the RTC.

2. RTC SCL: This switch enables the communication to communicate with the RTC
using 12C. Having this switch in ON mode it actives this communication,

whereas if it is in OFF mode it disables the 12C to reach the RTC.

3. NC: Not connected. This switch is not connected to anything, it doesn’t matter
if it is in ON mode or OFF mode.

4. NC: Not connected. This switch is not connected to anything, it doesn’t matter
if it is in ON mode or OFF mode.
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8.2  Analog Shield

B ZONE
SWITCH | ON | OFF
NC - -
Q0.2 Q0.2 | A0.2
Q0.1 Q0.1 | A0.1
Q0.0 Q0.0 | A0.0
o| NC
29| Q0.2
E <
gg Q0.1
%= Q0.0
[e)e]

Rev 2:12/11/2020

CZONE

SWITCH ON | OFF
NC - -
Ql.2 Ql.2 | Al1.2
Ql.1 Ql.1 | A1l
Q1.0 Q1.0 | A1.0
o NC

25| Q12

2z Qi1

| Q10

o0

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF, it

can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with Q0.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide

this analog output is represented with A0.X, being X any number of the tables above.
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9 GPRS/GPS 1/0s 5V pins

The GPRS/GSM Controller has some of the Mega board pins available. These pins can be
programmed according to Arduino features such as I/Os operating at 5V or any additional
features present in the pins (for example 12C communication in pins SCL and SDA). As these
pins are directly connected to the Arduino Mega board they are not as well protect as the
normal inputs. These pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarized in the table below. In order to access some
of these pins the configuration switch must be set to OFF position (see section 8) and some
extra considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TXO0 1
MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Mega board.

Apart from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

9.1 12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case
it reads 5V when nothing is connected. The pull-up configuration is stablished by default in
these pins.

If it is meant to work them as a GPIO at 5V, it has to be considered that they are pull-up
inputs.

9.2  Serial 0 - RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are already performing a function. This is because they are shared
with the USB interface. If using these pins, the USB communication cannot be working at the
same time. When the PLC is not installed, the USB communication is normally required for
debugging, uploading and intercommunicating with the Ethernet controller. If using both
interfaces at the same time the Arduino board will get blocked.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
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must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.3 SPI-MISO/MOSI/SCK

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Ethernet would not work.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

94 Pin3

This pin is only referred to the inputs 10.1. If the switch configuration is in OFF position the pin
Pin 3 will be available.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

95 Pin2
REMEMBER THAT PIN2 IS USED BY THE SIM800OL MODULE AS RESET PIN, SO IS NOT

AVAILABLE IN THE GPRS/GSM CONTROLLER!

IF YOU WANT TO USE SERIAL1, YOU MUST SET THE PIN2 ALWAYS AT HIGH POSITION.
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10 A Zone Features: Communications & RTC & uSD

10.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there is not any switch that affects it. So, it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.

10.2 RS-485
For RS485 communication protocol the defined Arduino Mega pins are showed in the chart
below.
Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects in this
communication. The RS-485 protocol will be always enabled, the only switch that affects is the
one called “FD rs-485 HD” (See Section 8). This switch makes the choosing between RS-485
Half Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

10.3 I2C

I12C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino Family. The pull-up
resistor is already implemented in the PCB.

Industrial Shields does not provide any library to implement the 12C as it can be used the
standard library of Arduino called Wire.
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10.4 SPI

The M-Duino pins used for the SPI bus are summarized in the table below. For SPI bus MISO,
MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,
each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 SO 50
MOSI 518l 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX1/TX1/RX3/TX3/Pin2/Pin3 21/20/1/0/19/18/15/14/2/3

Check the switch configuration at section 8 to enable SS pins.

10.5 TTL

M-Duino has two TTL ports, RX0/TX0, RX1/TX1. TTLO is accessed with the function Serial (pins 0
and 1 of the Arduino Mega). TTL1 is accessed with the function Seriall (pins 18 and 19 of the
Arduino Mega).

In order to use the TTL pins the configuration of the switches have to be the following one:

Switch Relay Shield
ON OFF

RX1/11.1 1.1 RX1

TX1/11.0 11.0 TX1

If the switches RX1/11.1 & TX1/11.0 are in OFF mode, the RX1/TX1 will be enabled. In order to
use TTL3 these switches must be in OFF mode.

10.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the compatible IC compatible
with Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible
with the M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS
Arduino Mega pin 10).
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10.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the 12C protocol.

4 switches have to be configured in order to enable the RTC features:

LEFT ZONE
SWITCH ON OFF RTC SCL & RTC SDA must be set to ON mode to enable
EE - - the 12C wires to the RTC. If they are in OFF mode, the
RTC SCL RTC : Arduino will not communicate with the RTC.
RTC SDA RTC -

12C must be enabled in order to communicate with the RTC. See section 11 12C to enable it.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation
called RTC.

10.8 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switches that configure it. However, there is a switch that
must be placed to ON mode in order to communicate with the uSD:

D53(SD): If this Switch is OFF, it enables the Chip Select of the microSD socket. If this switch is
ON, it does not enable any pin, so you must put the switch always at OFF position!

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal part and the socket is located
under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to
select the Chip Select of the uSD chip.

& Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the
operation of an online process or machine. Unexpected operation of a process or machine
could result in death or injury to personnel and/or property damage. Before inserting a
memory card, always ensure that the CPU is offline and in a safe state.

& Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la
carte mémoire.
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Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le
fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un
processus ou d'une machine peut entrainer la mort ou des blessures corporelles et / ou des
dégats matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est
hors ligne et en sécurité.

10.9 GPRS/GSM

The SIM800L module is the integrated module for the use of GPRS / GSM in this PLC and to
program it you must download the Industrial Shields Boards on your Arduino IDE.

You can test the GPRS / GSM functionality using the examples that come with the library:

© sketch_now0ga | Arduing 1613 - o %

File| Edit Sketch Tools Help

New Cri+N
Open.. 0
Open Recent >

Sketchback > )
Examples | : N
Clase Culew (zere t N oonce:
Save Ccuiss. T )| BO run once:
SaveAs.  ClleShiftes U7.Display
085trings
PageSetp CilsShiftP |  pousg
Print CQri+p 10StarterKit_BasicKit
Preferences  Ctrl+Comma QLR
Quit crleq o . !
/7 PUT yOUI  Adafat Circuit Playgiound >to run repeatedly:
Bridge >
Esplora
] Firmata
oM
LiquiaCrystal
Robot Control
Robot Mator
sD
seno
SpacebrewVun
Stepper
Temboo

RETIRED

Arduing DAL libeary
EEPROM

Ethemet

Ethermet?

GPRS

LoRa

RadioHead

RS-232
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11 Instructions for interconnection between Industrial Shields
controllers

11.1 RS-232 Communication:

M-Duino _ Another Industrial
GPRS/GSM ‘ ‘ Shields PLC
38AR I/0s PLUS

KRFC-6 Ferrite (4 Loops)

Rx
SHIELDED CABLE
Ferrite KITA Ferrite KITA
GND | H GND
12124V | @)OO( 12124V

< > < — >

11.2 RS-485 Communication:

11.2.1.1 Half Duplex

M-Duino ~_Another Industrial
GPRS/GSM | ‘ Shields PLC |
38AR I/Os PLUS
KRFC-8 Ferrite (4 Loops)

A S0 -A

SHIELDED CABLE

Ferrite KIT, Ferrite KITA
GND i | y GND
12124V mo@ | W 12124V

_ J — ,f 1 b

11.2.2 Full Duplex

M-Duino *_ Another Industrial
GPRS/GSM | | Shields PLC
38AR I/Os PLUS |

KRFC-6 Ferrites (4 Loops)

RS-485

Ferrite KITA - Ferrite KITA
GND ‘ SHIELDED CABLES ' GND
12124V >®O<>@ ‘ W 12/24v
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11.3 Ethernet

KRFC-6 Ferrite

Ethernet —

M-Duino Another Industrial
GPRS/GSM | Shields PLC
38AR I/Os PLUS

Ferrite KITA Ferrite KITA

GND H GND
g X FH OO Do

For an Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet
crossover cable must be used.
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12 1/0 technical details:

Digital Output Waveform:

[l o e——
y

DIGITALOUT

DIGITAL OUT

PWM OUTPOUT

leE

4

Pomem—ny

ARDUIND PAWM OUT

CHi= S.@al| |5 5,660 M 1.88ms | CHI % 268GEm.)
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Analog Out Turn On:

]

ANALOGOUT

ANALDG OUT

ARDLINO OUT
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13 Typical Connections

Rev 2:12/11/2020

(,fmfﬂ ISOLATED INPUT \

&
&

GND
Sharzev

‘] (100

o/,c;jﬁ.ﬁ

SHIELDED CABLE

Ferrite KITA

@l

i

SHIELDED CABLE

/ Dowrdoad e MDUND LAYOUT:
From®

I — S

P — .

Ferrite KITA

1y

— POWER

B oomawm

SHIELDED CABLE .|| Duumlon s MOURO LAVOUT:
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SHIELDED CABLE
2124V o

Ferrite KITA
0

=6

Rev 2:12/11/2020

0.7

SHIELDED CABLE Fromt wamdvesAS o \
< mt U

010V

SR,

Ferrite KITA

\J

224V

0.7

SHIELDED CABLE L}:“w \
S—"
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SHIELDED CABLE

0-10v

@ 51224V
GND
Ferrite KITA
GND A
12024V

Ferrite KITA

0.7

Rev 2:12/11/2020

SHIELDED CABLE Downioed e MOUINO LAYOUT!
i From: www.industrisishisids. com \

SR

B owemuour

Qo0 <)

SHIELDED CABLE

£\

L

SM2r24v
oA

VOUT = @/ Vde

SHIELDED CABLEf Pty drussentt felipocd \_

ALWAYS
CONNECTED
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SHIELDED CABLE

Ferrite KIT/ ®
GND VOUT = 0/ Vde
m{ﬁ

SHIELDED CABLE

DIGITAL / PWM ISOLATED
OUTPUT

* Sow the swilch
configutarion (ON)
Qivde H- 51224V
COM {-) { GND .&
J ALWAYS
JU1 CONNECTED
Ferrite KITA Q0.8 ® SHIELDED CABLE
f: POWER VOUT = Q/ Vide
"'L; I DIGITALFWA OUT

SHIELDED Cﬁﬂlﬂﬂ L e
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* Soo the switch
configutarion (ON)
Q/Vde
COM (=) gﬁw
Jn CONNECTED
Ferrite KITA 05 @
B Mﬁ] VOUT = Q/ Vide
224V DAGETALPWA OUT
SHIELDED ASL;/—ELT%
\J y
SHIELDED CABLE
—
(/_:uuoeou-rpur )
\I * Analog Outs no led r’f
indlicator
S B * See the switch
1[0 g Olos configutarion (OFF)
M.ii[{;u GND =
@3/0 g O| 02 AO5 E‘—” “'W)
g
ME SHIELDED CABLE
NCiOD O WI!/
Ferrite KITA —ia o
GND
= 9) |} power
20N | 8 ANALOG OUT
SHIELDED CABLE Dowibad o MOMOLAOUT: |
/ e
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14 Connector details:

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MC0,5/10-G-2,5THT

For 1/0 and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference | MC 0,5/10-G-2,5 THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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15 Mechanical Characteristics

- Dimension GPRS/GSM Controller:

101

54

129
L)

- DIN Rail mounting

Profilato o cappello TH 35-7,5
Top hat rail TH 35-7,5

153,

RO8

.

Prafilato o cappello TH 35-15
Top hat rail TH 35-15

15 5

e 3203 8
]
=
il
S 1+0.04
v Sezione A/ Section A g
0.3 mox - 2,2 min. finoa / To 2,5 max
= -
+l
B Sezione A/ Sedtion A
CARATTERISTICHE METODO  UNIA'  BLEND FEATURES TEST UNITS  BLEND
DI MISURA PC/ABS METHOD PUABS
Mecconiche  Resisereno KSTMD638  MPo 8 Mechanicol test Resistonce 1 tensil stess STHD M
Redisoreo o tuzionea nttw ISTIDB3E  MPo % Tonglostength ASTMD638 MR %
Alvmgamerto o rotvn KTMDE8 % 5 Utimonts dlongofi ASTMDE38 % 59
Modulo in fesione KTADIN _ MPo 2894 Fling modules ASTADTS0 MR 289%
Provg 170d con intogli 50180714 Xar' 55 lrod tost moiched 10180714 Xy’ 55
Termiche Temp. i pmmolimento Vit medo B ASTM DIS25°C 114 Thermal fest Vit sodte tute met ASTRDIS2S 114
Tomperoun Ricto 1 81 My K068 °C 9 Rebeting temperatue 1,81 WPg ASTMD848  °C 97
Fisiche Peso pecfic K092 géamd 1 Physical test  Spaciic gy ASTHDT®? _ géand 120
Rit nell STADSS % 0406 Mould hiinkage ASTMD9SS % 0406
Mol Flow Index 260°C - 98N KSTNDIZE  o/10° 111 Melt Flow Ines 260°C - 98N ASTMDIZ38 10’ 11
Comportamento Auesinguerea (mm di spesor) I} - V-0(08) Flame test Sef atinguisher (ideess in mm) o4 - V-0(0.8)
allo fiomma _Fib Incadescen 37 mm 69521 °C 960 Inndestents thiepd 32 mm 169521 C 960

Ialtronic si riserva il diritto di modificare il materiole con cui realizzn i propri prodotti

senzo obbligo di preawiiso.

Itoltronic con operate ony change of the moterials without being obliged to forewam.
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16 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the 1/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino 42 1/0Os PLUS from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino 42 I/Os PLUS. When configuring the layout of the M-Duino 42 1/Os PLUS inside
your panel, consider the heat-generating devices and locate the electronic-type devices in
the cooler areas of your cabinet. Reducing the exposure to a high-temperature
environment will extend the operating life of any electronic device. Consider also the
routing of the wiring for the devices in the electric cabinet. Avoid placing low-voltage
signal wires and communications cables in the same tray with AC power wiring and high-
energy, rapidly switched DC wiring.
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Provide adequate clearance for cooling and wiring M-Duino 42 1/Os PLUS. Is designed for
natural convection cooling. For proper cooling, you must provide a clearance of at least 25
mm above and below the devices. Also, allow at least 25 mm of depth between the front
of the modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquid filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25¢cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
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- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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17 Revision Table

Revision Number Date Changes
0 29/08/2019 First implementation
1 02/03/2020 Second implementation
2 23/11/2020 Third implementation
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruités de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com
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